User Interface

The updated modern UI in AutoCAD® 2013 software just gets easier and easier to work with.

Welcome Screen
Who doesn’t love a friendly welcome to start your AutoCAD day! The new Welcome Screen provides easy access to drawing files, learning tools, and online content.

Create new or open existing drawings from the Work panel. You can also quickly access recently used drawing files.

**TIP** Check out the “What’s New in 2013” videos to get up to speed in no time!

Easily download a variety of valuable apps from Autodesk Exchange Apps. Connect to Autodesk 360 and AutoCAD social media resources.

Command Line
You command line fans will love its new enhancements, including control over color and transparency. Float the undocked command line (which defaults to a single row) above the AutoCAD drawing window. Notice the semi-transparent prompt history (displaying up to 50 lines) doesn’t affect the drawing area.

Select the new customize tool on the command line to control the number of lines of prompt history as well as Auto-complete, Transparency and Options.

F2 (or the flyout at the right end of the floating command line) will display the history window. Click on the >_ at the left to quickly access previously used commands.

**TIP** You can make the command line nearly completely transparent so that it just displays when you hover over it.
For those of you who prefer the command line at the bottom (or top) of the drawing window—you can dock it right back into place.

Notice that the command name is always displayed on the command line. You can even click on the various command options (displayed in blue) from the command line!

Feeling groovy? Change the color of the command line from the Colors tool (Display tab, Options dialog box).

**AutoComplete**

Save time (and spelling frustration) with AutoComplete! As you key in commands, AutoCAD automatically completes the entry. If you pause, a list of all possible commands and system variables displays for easy selection.

**TIP** Customize AutoComplete from the command line right click menu (even control the delay response time).

**Implied Selection**

When selecting objects (outside of a command) you’ll find the additional options of Wpolygon, Cpolygon and Fence appear.

Can’t decide whether you prefer pick and drag or picking two points to define a window? The new PICKDRAG setting of 2 combines both options.

This setting also allows you to start a window even when picking on an object (for those crowded drawings). This only works outside of a command.

**1st Pick Point**

Control the display of these in-canvas viewport controls from the 3D Modeling tab of Options.

**NOTE** By default, SNAPMODE now temporarily turns off when selecting objects. This can be set back to legacy behavior in the SNAP command.

**In-Canvas Viewport Control**

It’s easier than ever to set up or modify your viewports, 2D and 3D views and visual styles directly from the drawing window (big time saver)!

*Love this timesaver! Double click on the [-] (first column) to quickly display 4 viewports or the previously specified viewport configuration. A simple click on the + in the corner of any viewport will fill the screen with that viewport.*

**In-Canvas Property Preview**

Dynamically check out object properties as you select them (including transparency)! Get the right property value every time!

Property Preview can be controlled in Options (Selection tab).

**TIP** Love this timesaver! Double click on the [-] (first column) to quickly display 4 viewports or the previously specified viewport configuration. A simple click on the + in the corner of any viewport will fill the screen with that viewport.

**BONUS TIP** The In-Canvas Viewport Controls contain a speedy way to get to your saved views (under Custom Model Views).
Autodesk Content Explorer

Speedy searches for all types of content including blocks, attributes, layers, styles, etc. can be done with Autodesk Content Explorer. Found in the Plug-ins ribbon tab, Content Explorer can search through thousands of files almost instantaneously including Autodesk Seek web service (much faster than Design Center)!

Filter content and switch between thumbnail and detail views. Drag content into your current drawing or open the source file from Content Explorer.

The Add Network Content option has changed. Now it’s a drop-down list that says Add Content Provider. In the list, the option for Autodesk Content Service replaces the previous Add Network Content button.

Use Autodesk Content Service to specify computer name or IP address of the network computers.

AutoCAD 2013 includes basic indexing support for any file that can be opened, imported and attached using AutoCAD. Drag and drop local folders for searching from Windows Explorer or use the Add Watched folder option.

Install the Autodesk Content Service (found on the AutoCAD 2013 installer) on network computers to add watched folders from other computers.

Multifunctional Grips

In AutoCAD 2013, Multifunctional Grips exist on so many different objects! Editing commands reside with the object (which means less time searching).

Look for these powerful grips in lines, polylines, arcs, elliptical arcs, dimensions and multileaders. 3D faces, edges and vertices also have them. Just hover over a grip to access numerous relevant options.

Multifunctional grips are even more powerful when dynamic input is on. Use the Tab key to jump between input boxes.
Nudge!
Have you ever wanted to move objects over by just a few pixels? Try using Ctrl plus your arrow keys!

Osnap Enhancements
Added flexibility helps AutoCAD find object snap points to make objects tangent or perpendicular. Choose from multiple snap points based on the location of the cursor.

Copy Improvements
Use the handy new Array option in the Copy command to create a linear (non-associative) array on the fly. There’s even a Fit option!

Groups
Groups are in many a CAD guru’s bag of tricks. Now you’ll find easy access to Groups on the Home tab of the ribbon.

A group is a saved set of objects that you can edit together or separately when needed. Groups make it easy to manipulate a group of objects as a unit.

TIP Use Shift+Control+A to quickly turn Groups on and off.

Fillet and Chamfer
New previews display when passing the cursor over the second object in the Fillet/Chamfer commands. Confirm and change the radius or distance before completing the command!

NOTE Now you can fillet splines!

Express Tools become “Real” commands
The NCOPY Express Tool is now a core AutoCAD command. Copy nested objects from Xrefs, blocks and DGN underlays (no need to explode or bind)!

Use the Delete Duplicates tool (OVERKILL command) to clean up your drawing and remove duplicate geometry.

JOIN Command
The JOIN command is so much more easygoing now! You can join lines, arcs and polylines to 3D polylines or splines as long as they are contiguous. You can also join a helix to a spline.

NOTE Join now supports standard selection methods (such as crossing) or picking objects in any order!

New Blend Tool
Use the Blend command to create spline objects between two objects (Modify panel of the Home ribbon tab).

Control OVERKILL settings in the dialog box. Specify which object properties to ignore along with whether or not to optimize polyline segments and/or combine co-linear objects. The tolerance value controls the precision by which OVERKILL will operate.
Associative Arrays

An associative array treats the entire array as a single object (much like a block). This makes it easy to edit the properties of the array after the fact. But unlike a block, you can still manipulate the individual objects.

There are three types of associative arrays: rectangular, polar, and path options. The visual preview makes it easier than ever to get your array right the first time. Rectangular arrays are automatically displayed in a 3 row by 4 column grid. Polar arrays are displayed in a full circular pattern of 6.

Arrays are easy to manipulate with multifunctional grips or the Properties palette. The contextual ribbon tab and right click menu are also simple means of editing an associative array.

Individual items in an array can be selected and edited by using the Ctrl key. Use the new Replace Item tool to replace selected instances with other objects.

**TIP** The Reset tool returns the items to their default size and position.

**Path Arrays**

With path arrays, you can distribute items evenly along a specified path. The Measure option is used to specify a distance between the items. Use Divide to specify the number of items. (AutoCAD will space them evenly along the path.) If the path is modified—the arrayed objects will follow!

A valid path option is a line, polyline, 3D polyline, spline, helix arc, circle, or ellipse. After selecting objects and a path, AutoCAD will display the objects evenly along the entire length of the path.

Use the Align Items and Z Direction options to specify whether the arrayed objects should maintain the starting orientation or adjust to remain parallel to the path.

**TIP** Use Base Point to control the position of the arrayed items relative to the path.

**BONUS TIP** Explode an array to remove the associativity.

The new item count toggle allows you to indicate a specific number of items to be arrayed, or to fill the path with the items. When off, an additional grip at the end of the array appears to provide dynamic editing.
3D Associative Array

3D associative arrays are also very powerful. Indicate the number of levels (the number of items needed in the Z direction) and specify the distance between levels.

**NOTE** A distance of 0 between levels would create all rows at the same elevation.

External References

Passing the cursor over the edge of an attached image, DWF, or PDF will display a selection preview frame (even when frames are turned off). You’ll also find this when you pass your cursor over geometry inside of attached DGN or DWG files.

**NOTE** The system variable FRAMESELECTION controls this behavior.

The External References palette includes an option to detach data extraction tables from a drawing. You’ll also find that the corresponding reference highlights in the External References palette when selected. (Making it easier to select the correct reference!)

Now you can edit the Saved Path directly in the External References palette (Found path is read-only). Relative Path is the new default (unless the relative path is not available).

**TIP** You can easily fade reference files from the Reference panel on the Insert tab.

Annotation

Mtext background mask remembers the last used fill color and offset. (No more defaulting to red and 1.5!)

You can control the gap around multileader text in a text frame. You can also extend the leader line all the way to the text (rather than ending at the bounding box).

**TIP** Remove Style Overrides has been added to the right click menu when you select a dimension.

Now you can strikethrough mtext, multi-leaders, dimensions and tables.

Leaders are now part of the TextToFront tool.

Wipeout Frames

The new WIPEOUTFRAME system variable lets you display the wipeout frame without printing it.

Hatch

It is now possible to edit multiple hatch objects from the ribbon or from the command line version of the hatch editor.
Reverse Polylines
Set the new PLINEREVERSEWIDTHS system variable to 1 if you want widths reversed when the REVERSE command is used.

Spline Enhancements
AutoCAD 2013 supports periodic splines with C2 continuity. The knot parameterization property of a spline is no longer read-only.

NOTE You can now use the Extend command to extend spline objects!

Layers Improvement
Use the right-click menu in the Layer Properties Manager to quickly freeze specified layers in all viewports except the current one. (Handy!)

Offset Preview
Finally a preview in the popular OFFSET command!

Quick View Drawings and Layouts
It’s easier to distinguish the current active view in Quick View Drawings and Layouts with the colorful border and bolded text.

NOTE UCS icon selectability can be controlled in the UCS dialog box (Coordinates panel, View ribbon tab in the 3D Modeling workspace).

Additional controls appear when you right click over the UCS icon.

3D Tips

UCS Enhancements
Use the UCS icon’s multifunctional grips to directly manipulate the coordinate system. Easily move and align the origin with objects (including curved surfaces and solids). Select the UCS icon and choose from the various menus that appear as you hover over the grips.

NOTE The UCS icon also displays a dynamic preview in the UCS command.

3D Object Snaps
A 3D Autosnap control has been added in Options so you can distinguish between 2D and 3D Autosnaps with different colors.
Solid Modeling

Fillet Edge and Chamfer Edge: Found in the Solid tab, the Fillet Edge and Chamfer Edge tools provide a dynamic preview and support direct manipulation by pulling on the attached grip.

Chain and Loop Selections: Selecting contiguous edges and curves is just so much easier! SURFPATCH, SURFBLEND, MESHCAP and FILLETEDGE now detect contiguous edges with a solid or mesh object (or within/between surfaces).

A new Loop option (much like a closed chain) can be found in FILLETEDGE and CHAMFEREDGE.

Offset Edge: Create an offset curve from a planar face on a 3D surface or solid. Offset to the inside or outside using your cursor to produce a polyline or spline and indicate sharp or rounded corners.

Follow this up with Presspull or Extrude to easily add or remove the bounded area from a solid.

3D Model Import

So many file formats—so little time! Now you can import a much wider variety of file formats including CATIA, NX, Pro/Engineer, Rhino, SolidWorks and Inventor.

The data is translated to native AutoCAD geometry and inserted into the drawing as blocks. Parts and assemblies are preserved as nested blocks. And of course you can edit the objects. Just explode it first!

PressPull

Use the new Multiple option or the Shift key to press/pull multiple objects in a single operation. Now you can select 2D and 3D curves as well!

Surface Curve Extraction

Use the new Extract Isolines tool (Surface ribbon tab) to quickly extract isoline curves from an existing surface or face of a solid.

You can change the direction of the isolines, select a chain or draw a spline on the curved surface.
With Inventor Fusion you can quickly and easily insert standard, counter bore, or countersink holes, and add or modify fillets and chamfers along with many other 3D capabilities. Fusion is very intuitive and easy to use (and addicting)!

When you are finished editing your model in Inventor Fusion, return to AutoCAD by selecting the Return to AutoCAD tool.

In Fusion you can zoom, pan, and orbit to navigate around your model similar to AutoCAD. You’ll even find the familiar Navigation bar and ViewCube.

The power in Fusion is the direct editing capabilities. Intuitively edit and validate models from almost any source. Click on a model edge or face to select it for editing. Press the Ctrl key to select multiple objects (just as you would expect).

The ribbon interface as well as context-sensitive right-click options provides easy access to relevant editing tools.

**NOTE** You must install Autodesk Inventor Fusion 2013 to use it.

After installing, it can be found in the Plug-Ins tab on the Ribbon. When you select a surface or solid in AutoCAD, the Edit in Fusion tool is automatically displayed at the right end of the context-sensitive tab.

Use the very cool Autodesk® Inventor® Fusion technology to easily edit and validate models from almost any source. The super-friendly and intuitive direct manipulation capabilities provide direct modeling for speedy design changes in 3D.

Without exiting AutoCAD, you can launch Inventor Fusion, use it to modify a 3D model, and then continue working on the modified objects in AutoCAD.
It’s never been easier to go from your 3D models to 2D documentation. You’ll even find that if you modify the 3D model, the 2D documentation will update as well!

The Model Documentation commands are found on the new Layout tab.

**Base View**

While in a layout, use the Base View tool to automatically display a scaled preview of the model attached to the cursor. Use the new Select option to specify which 3D objects are represented in the base view (also available after the fact). Specify options such as type, orientation, and scale to create your base view.

**NOTE** The Select option switches temporarily to model space.

New to AutoCAD 2013, you can select objects in model space and then use the Base View tool (choose the From Model Space option). You will need to specify a layout name.

**TIP** AutoCAD will automatically create a new layout if necessary and make it active. Kill two birds with one stone!

**Projected Views**

Create projected views from the base view (as long as the Type option was set to Base and Projected) by dragging the cursor to the desired location. AutoCAD automatically creates the appropriate view.

**NOTE** You will notice that relevant layers with a MD_ prefix are automatically added to your drawing when you create drawing views.

**TIP** To break the alignment, select the center grip and then hit the shift key once to break the alignment. Repeat this process to restore the alignment.

**Section Views**

Creating section views is as easy as picking the points of the section line on an existing view! The Section View Creation tab includes tools such as depth and hatch controls.
Once you've created a section view, a section identifier will display. As more section views are added the identifier automatically increments. You can also display a view label displaying section and scale.

Use the Edit Components tool to modify the objects used in the Section View. If a component is set to none, it will not be sectioned.

**NOTE** You can also specify full depth or just a slice.

Use the Section View Style Manager to customize the section views to meet your standards.

**TIP** Use Multifunctional grips to modify the section line.

Grips on the section view, hatches and section view label allow you to make a variety of modifications.

**Detail Views**

It's easy to create detail views in AutoCAD 2013. Specify a circular or rectangular boundary, smooth or jagged edges, connection lines, etc. from the context-sensitive Detail View Creation tab.

A detail view label is automatically inserted (and incremented if necessary).

Use the Detail View Style Manager to control the appearance of the label, boundary and detail view.

Easily modify a detail view after the fact by using grips on the detail symbol, view or view label or on the Detail View Editor tab (which appears when a detail is selected).

**View Symbol Sketch**

Why not constrain section lines and detail boundaries to key points of geometry? This will help ensure accuracy should the model change.

**Associative Dimensioning**

Dimensioning of these drawing views is much smarter—and will automatically update as the model changes.

If you invalidate or disassociate annotations, the new Annotation Monitor will help you identify and correct the disassociated annotations.
Found on the status bar, the Annotation Monitor icon changes and issues an alert on each of the disassociated annotations. Click each alert to reassociate or delete individually, or select the link on the alert bubble to quickly delete them all.

Automatic View Update
AutoCAD clues you in when the source model changes (making your drawing views out of date). The new Auto Update tool controls whether or not drawing views are updated automatically when the source model changes.

Point Clouds
Point Clouds can now be easily attached and managed from the External Reference Manager. The Attach Point Cloud dialog box now provides a preview and more detailed information.

A new bounding box appears when you select a point cloud (making it easier to visualize its position in 3D space). The new Point Cloud ribbon tab also appears with all the necessary Point Cloud tools. If intensity data is included, you can use the analysis tools to view point intensity with different color schemes.

Applying Standards
Specify drafting standards for new drawing views in the Drafting Standard dialog (found on the Styles and Standards panel).

TIP Use the Export Layout tool to export your finished drawing views to model space (found in the right click menu of the layout tab). Drawing views containing circular objects now export as circles and arcs rather than polylines.

TIP Now you can clip a Point Cloud! AutoCAD 2013 supports raw scan files from major industrial scanner companies (such as Leica, Topcon and Faro).
Indexing provides a noticeably smoother and faster workflow. The new Create Point Cloud File dialog allows you to select multiple files to batch index and even merge into a single file. Point cloud indexing is significantly improved for smoother and more efficient workflow—especially when working with raw scan files.

Autodesk 360

It’s all about the cloud, baby! Connect to your secure Autodesk 360 account for file sharing, customization syncing, and more.

Default Cloud Settings

Be sure to set up your cloud settings to control when your design data and custom settings are synced. Choose to automatically store your design data each time you save, or only when you specify.

Customize your settings from the Online tab in Options, the Online tab of the ribbon or the Autodesk 360 sign-in dropdown menu.

Sync Your Settings

We all set up AutoCAD to work the way we like to work! Now you can save and sync those settings with Autodesk 360. Save your program appearance, profiles, tool palettes, customization files, Options and support files to Autodesk 360 so you can restore them onto any computer!

NOTE When you upload drawings from AutoCAD to Autodesk 360, external references and other dependent files upload as well!
Autodesk 360 tool
The new Autodesk 360 tool takes you online to your stored documents and folders via browser.

**NOTE** You’ll also find Autodesk 360 access in many of the Select File dialog boxes

**Online Options tool**
Monitor your online storage capacity, control interaction with cloud documents and your customization from the Online tab in Options.

**Open on Mobile**
If you are signed in to AutoCAD WS on your mobile device (with the same login), AutoCAD will open up the current drawing on it.

**Sync My Settings**
Use this tool to start and stop syncing of your settings.

**TIP** Specify the cloud folder you want your files saved to for easy management.

If you choose to sync your settings, but your online settings are different than your local ones, AutoCAD will prompt you to confirm the proper action.

**Added Extras**

**Render Online**
One of the great advantages of the cloud is its extensive computing power. Select Render in Cloud from the Render ribbon tab to render your 3D AutoCAD models while you continue working on your computer!

**Raster Files**
AutoCAD 2013 accepts more file formats for attaching: DDS, DOQ, ECW, HDR, JPEG2000, MrSID, NTF, OpenEXR, and PSD.

All images from AutoCAD Raster Design are automatically displayed.

**Migration**
Tool Palettes (including groups) and Materials Libraries migrate from previous releases (with better results). You can also easily return to the default settings with the Reset Settings tool found in the Windows Start menu.

**Share Document**
Share the current drawing with others via email. You can control the access level of those you choose to share with.

**Collaborate Now Tool**
The Collaborate Now tool launches AutoCAD WS and initiates a collaboration session with another AutoCAD WS user.

**NOTE** The CAD Manager Control Utility allows CAD Managers to control their users’ access to Autodesk 360 and customization synchronization.
**Autodesk Seek**

Don’t miss out on the great content available (for free!) up on Autodesk Seek service. Easily get to Autodesk Seek from the Content panel on the Insert tab or from inside of Design Center.

Nearly 350 manufacturers and 90,000 parts are available on Autodesk Seek (over 30,000 DWG files).

**Language Packs**

Do you need to install multiple languages of AutoCAD on your computer? Now you install one full product and then add subsequent languages via Language Packs (from the Help menu). Saves so much time and space!

**Multiple search paths for plot files**

You can now specify multiple folders for PC3, PMP, CTB, and STB files in Options.

**DGN Support**

Complex linetypes are now maintained!

To ensure that custom linetypes are displayed, copy the corresponding.rsc files to the support path or add the RSC file path to the search path in AutoCAD in the Options dialog box (Files tab, Support File Search Path).

**DWG Convert**


You can save the conversion setups for future use and specify options such as purging the drawings.

**Stay connected!**

Use the new tools in InfoCenter to make it easy for you to stay connected with your AutoCAD community. Download product updates, access the Autodesk Subscription Center, view the AutoCAD Facebook page, and even follow AutoCAD Twitter posts!

TP Use DWGCONVERT to quickly replace page setups in multiple drawings!

**Autodesk Exchange Apps**

Now get direct access to downloadable applications and content that can increase your productivity. Simply click on the big X on Infocenter.
AutoCAD WS

Have you tried AutoCAD® WS web service yet? AutoCAD WS lets you view, edit, and share drawings through the web or mobile device (take your drawings on the road!). Collaborate with others on the same drawing in real time! Use the basic editing features to mark-up a drawing file. Use the Timeline tool for a detailed design history.

Give AutoCAD WS a try—did I mention it’s free? Download the free* app for iOS mobile devices at the App Store. Also available for the Android. Visit www.autocadws.com today!

*Free products and services are subject to the terms and conditions of the end-user license agreement that accompanies them.

AutoCAD Design Suite

Enhance the power of AutoCAD with easy-to-use visual communication solutions. AutoCAD Design Suite helps designers work more creatively, rapidly evaluate designs in context and effectively communicate and sell ideas.


The Premium version of the suite adds Autodesk® 3ds Max® Design. The Ultimate version of the suite also adds Autodesk® Alias® Design.

Autodesk SketchBook Designer

Sketch conceptual designs directly in AutoCAD. Tap into a unique hybrid paint and vector workflow and explore many different design concepts. Communicate your ideas graphically!

- Illustrate on a blank screen
- Design conceptually with pencil and paper-like sketching
- Combine and compose images
- Create graphic designs and communications
Autodesk Showcase
Quickly and easily transform your AutoCAD designs into compelling imagery, movies, and interactive presentations for design reviews and sales pitches. Evaluate design variations and accelerate feedback by reducing the need for physical prototypes and long rendering times.
- Accelerate the path to new business by selling your ideas more effectively
- Reduce the time, expense, and expertise required to prepare visualizations
- Facilitate informed decision making by viewing design options in context and in detail

Image courtesy of Hurni Engineering, Jean-Marc Benoit

Autodesk Mudbox
Refine your models with Autodesk Mudbox. Its powerful textured painting and digital sculpting toolset lets you finesse the details of your ultra-realistic models.
- Get fast, smooth, and accurate results with a world-class 3D sculpting toolset
- Paint directly onto high-resolution 3D models and see results immediately
- Create accurate normal, displacement, and ambient occlusion maps with texture baking

Image courtesy of Benjamin Brosdau

Autodesk Raster Design
Get more value from your raster imagery (such as scanned drawings, maps, aerial photos) with Autodesk Raster Design.
- Easily clean up, edit, enhance and maintain scanned drawings in a familiar AutoCAD environment (includes despeckle, bias, mirror, and touchup).
- Raster to Vector Conversion, including OCR (Optical Character Recognition) gives you accurate results when you create lines and polylines from raster data
- Use standard AutoCAD commands on raster regions and primitives; easily erase raster lines, arcs, and circles.

Autodesk 3ds Max Design
(Available in Premium)
Perform daylight analysis and create cinematic-quality 3D visuals with the animation, character, effects, and point-and-shoot rendering and lighting analysis tools. Convey the story behind your design for design reviews, marketing materials, or public outreach—before it’s real.
- Benefit from optimized compatibility with Autodesk and third-party solutions
- Analyze lighting scenarios with confidence
- Bring your design to life in a highly realistic way using 3D technology proven in the entertainment industry

Image courtesy of Homologue
Lynn Allen, Cadalyst columnist and worldwide Autodesk Technical Evangelist, speaks to more than 30,000 users each year. For the past eighteen years she has written a column in Cadalyst magazine called “Circles and Lines” and is the voice behind Cadalyst’s “Tips and Tricks Tuesdays”. Lynn started using AutoCAD software with Release 1.4, over 20 years ago, and got her start by teaching at the corporate and collegiate level for 12 years. A sought-after public speaker with a unique comedic style, Lynn has served as the Autodesk University emcee for ten years and is always one of the highest rated speakers. Her latest book is entitled AutoCAD Professional Tips and Techniques.

Cover: Image courtesy of Castro Mello Architects

Autodesk, AutoCAD, ATC, DWF, DWG, Inventor, View-Cube, ShowMotion, SketchBook, Showcase, and Mudbox are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, and specifications and pricing at any time without notice, and is not responsible for typographical or graphical errors that may appear in this document.

© 2012 Autodesk, Inc. All rights reserved.